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A BiblioYou Tutorial

Formatting of a simple text-based print book,
from start to finish

There are many ways to format a book for publication. This tutorial works through a basic
formatting of a simple Microsoft Word based book. Once these techniques are learned, there are
many simple steps that can be added to “spice up” the design of the book. It is best to follow this
step-by-step tutorial with your book file open, repeating the steps outlined on the book you are
preparing.

*Note that this reformat is being done in Microsoft Word 2007. The window may look different
versions of Word. Word'’s formatting preference selections in this document are underlined. These
are items that may look different or that may be found in a different placement on other versions of
Word. Often these selections are also found in drop down menus at the top of a Word window.

Remember, BiblioYou offers a list of publishing professionals that can help prepare your book.
Need Help? (Click Here)



1. Open your text-based file in Microsoft Word. This file is formatted at 8 %2” x 11”. We will be
reformatting it to a small paperback size of 5 12” x 8 %2”. The book can be formatted to most any size
at this point, but it is very important that the size is adjusted before any further formatting. Figure 1
shows the initial format for this book.
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2. Choose the Page Layout tab, then click on the bottom right corner of the Page Setup section of the
tools panel. (Figure 2)

*(Note that this selection is also available as a drop down from File at the top of the window. When
using different versions of Word, this may be the only place such selections would be available)
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3. The Page Setup window will open (Figure 3)
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4. On the Margins tab, set the Top & Bottom margins to .8” and the Left and Right margins to .7”.
Make sure Whole Document is set at bottom.

(Figure 4)

(These can be set to any value according to preference)
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5. Click on the Page tab (Figure 5).
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6. Set the Page Size to Half Letter, or Width of 5.5” and Height of 8.5”. Make sure Whole Document is
set at bottom. (Figure 6)
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7. Click on Layout Tab. (Figure 7)
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8. Make sure the Different odd and even, and the Different first page boxes are checked. Make sure
the Header and Footer are set at.5”, and the Vertical alignment is set to Top. Make sure Whole
Document is set at bottom. Click the OK button. (Figure 8)
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9. You will see that the page is now formatted to the new size. Notice that the lines are double-
spaced. We want to set the spacing to single spaced, like most commercial books. (Figure 8)
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10. First select all of the text in the window. Select it all with keyboard stroke Command + A in Mac,

or Control + A on a PC (also available under Edit dropdown). Then Right Click anywhere on the

selected text, drop down to Paragraph and click. (Figure 9)
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11. The Paragraph widow will open. (Figure 10)
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12. To set up your book with “Block” paragraph formatting, in the Indents and Spacing tab, set Left

and Right Indentation to 0”, Set Special to (none), set Spacing for Before as Opt, After as 10pt (Or
whatever you'd like), and Line spacing as Single. (Figure 11)
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13. To set up your book with “Indented” paragraph formatting, in the Indents and Spacing tab, set
Left and Right Indentation to 0”, Set Special to First Line, set By to .3”, set Spacing for Before as Opt,
After as Opt, and Line spacing as Single. (Figure 12)
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14. Now click on the Line and Page Breaks tab (Figure 13)
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15. Make sure Window/Orphan control, and Don’t hyphenate are checked, and all other boxes are
unchecked (Figure 14)
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16. You will see that spacing now has the appearance of a professional book (Figure 15)
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17. Place an insertion point before “Chapter One” (Click before C). On the Page tab, Click on the
Breaks button, drop down to Next Page and click. This will move the insertion point to the next page
and create a Section. Section breaks are useful for creating different visual aspects for different
parts of a book, and for creating a Table of Contents, especially when an eBook is later created for
the final print formatted file. (Figure 16)
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18. Notice that Chapter One has moved to a new page. (Figure 17)
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19. At this point, click on the Show Non-printing Characters button (looks like a backwards P). This
will show formatting marks, and breaks. Notice that the insertion that has just been created now
shows Section Break (Next Page). (Figure 18)
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20. Click the bottom right corner of the Microsoft Word window and drag to the left until there are
only two pages showing, or resize the magnification by dragging the slider to the left to make the
pages larger, again, until two pages are showing. This will help you to visualize the front and back of
a two-sided book page. (Figure 19)
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21. Now you will want to clean up the formatting of your pages as you go. For example, delete
spacing between the Introduction title and the text. (Perform these tasks according to your own
preferences) It is useful to note the items like the number of Paragraph Marks between the word
Introduction and the text below. In this case, 3 marks. Repeating this in following sections
(chapters) will ensure uniformity throughout the book and make it look more professional. (Figure
20)
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22. Notice that the Introduction page is on the right size of the two page set. The Left/Right setup
reflects the Front/Back of a book page. You will want to insert a new Page Break to move the
Introduction page down to the next Left page. (Figure 21)
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23. You now see the proper setup for the beginning of each section. Repeat this technique
throughout the book.(Figure 22)
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24. As you work through the spacing and section breaks of each chapter, you can change the font
format for titles in the book. In this case, we select the Home tab, and change the font for
“Introduction” to Cooper Std Black, font size 14 (or whatever you would prefer). Again remember
this preference for later chapter headings. Also, notice the indentation offset in the ruler area above
the page on the right. (If the ruler isn’t visible, click on View at the top of the window, drop down
and click the Ruler selection to show it) This was created when setting the indentation of the first
line for each paragraph. This is also affecting other parts of the book, in this case, the header area
for the chapter that we are in. “Introduction” and the quote below it are shifted to the right and will
need to be moved back to the left. (Figure 23)
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25. Notice in Figure 24, we highlight the header area. Then notice the two facing pointers on the
ruler area indicating indentation. Select the top pointer and slide it back to the edge of the margin
matching the two arrows. This will re-center the header for the chapter (assuming it was centered,
or if it was left justified, will move it to the left edge of the text). This can also be done in the
Paragraph dropdown used before. (Figure 24)
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26. Now it’s time to set up the Header and Footers for the book. This is a slightly complicated
process in which you essentially “Train” the word file as to how you would like the header and
footer to appear. First double click in the area above, or below the text on the page to open the
Header/Footer area for editing. Notice that the text for the book is grayed out and not editable, and
there is some extra information shown in the tabs for the header and footer. You will find the
Even/0dd Page designations, the Section number, and whether the header for a particular page is
connected to pages before it (Same as Previous). Note that Same as Previous not only refers to the
page right before the page in questions, but also to the page that matches it in Odd/Even
designation (The page that is two pages before the page in question). This is an important theory to
keep in mind when setting up the header and footer text in directions to follow. Notice in Figure 25
that the tools panel at the top has changed. The Header & Footer Tools panel is now available. You
will be leaving from and returning to this panel during this process, so remember where it is.
(Figure 25)
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27.To start the process, return to the beginning of the document. (Figure 26)
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28. Notice that you can click on the Home tab to access the font tools. We will be going back and
forth between the font tools and the Header & Footer Tools tab. (Figure 27)
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29. We will start with the insertion of pagination. Place an insertion point into the footer of the first
page. (Figure 28)
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30. In the Header & Footer Tools tab, click on the Page Number button, and drop down to and click
Format Page Numbers. (Figure 29)
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31. The Page Number Format window opens. Note that there 2 sets of items that you will be
working with. The Number format and the Page numbering. In this case, we will adjust the Number
Format to small roman numerals for the beginning section of the book, followed by numbers for the
rest of the book. For the Page Numbering, we will adjust between “Start at” and “Continue from
previous section.” (Figure 30)

ede] = Mecrotol S Hescer &

Fevew  View Oesign
3 = (35 - I Tirrevomitemon W Ofterent feit Page Bl Headertiomtep: 05"
-~ - O] e »
3\ tea section 7 Offerent Odd & fven Pager [ Feoter from Bottom: 05"
Oate Quck Mture Ohp Gote ' - -
An Header Tester T Lmk 10 Previows | W Show Document Test [ vsert Adgnmant Tan

VHANS AR E ALY

Chapter starts withstyle: [Headng1 |~ |
Use separator: [ typhen) [~]
Examples: 1-1, 1-A

AP N TS

) Continue from previous section
© startat: 1

SR L]

J [ conce ||

PSSR

Figure 30



32. We will set the page number for the first page in the book. Under Number Format, change the
drop down to small roman numerals. Leave Page numbering at “Start at” i. (Figure 31)
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33. Now, click in the Page Number button, drop down to Bottom of Page, then drop down to Plain
Number 2 which will center a page number at the bottom of the page. Note that there are numerous
options for page number placement under the Page Number dropdown, and under the Footer
button found just to the left of the Page Number button. . (Figure 32)
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34. Notice that the first page now has page number i, and the second has page number 1. (Figure
33)
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35. Now highlight the page number on the second page. Click the Page Number button and drop
down to Format Page Numbers. (Figure 34)
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36. Under the Number format setting, select the small roman numerals setting. Under Page
numbering, click the Continue from previous section radio button. (Figure 35)
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37. Note that the first two pages are now number i and ii. (Figure 36)
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38. Continue this process through the rest of the pages for the opening portion of the book. Note
that for this book, the opening pages continued to page viii. Now, the beginning of the main portion
of the book should be starting at page 1, and should continue numbering properly. If not, follow the
procedure above, using the numbers selection for Number format. (Figure 37)
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39. Note that as the book proceeds from Section 8 to section 9, in this case from Chapter one to
chapter two, the page numbers restart at 1. This does not always happen, but if it does, highlight the
page number 1, click the Page Number button and drop down to Format page numbers. (Figure 38)
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40. Leave the Number format the same, and select the Continue from previous section radio button.

(Figure 39)
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41. You will see that the page numbering has continued. Browse through the rest of the book file,
and follow this procedure if this occurs again. (Figure 40)
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42. Now, let’'s work on the headers. Go back to the beginning of the book file. (Figure 41)
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43. We are going to place the author’s name on the top of the right page (back of the page) and the
title of the book on the top of the left page (front of the page). When the user looks at the book, we
want them to see the text on the outside edge of the page, not near the spine of the book. To
accomplish this, we will align the author’s name to the left of side of the page, and the book title to
the right. In this two page setup, it is easy to remember this setup by aligning both toward the
center of the two pages.

Let’s start by typing the author’s name on the top of the second page. You'll notice that the name
also appears at the top of all of the other pages. (Figure 42) We will now work to control this
behavior.
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44, Click the Design button under the Header & Footer Tools. Notice the Link to Previous button
that is yellow. Place an insertion point in the header of the second page. Unclick the Link to Previous
button (It will no longer be yellow)(Figure 43)
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45. Select the author’s name at the top of the first page. (Figure 44)
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46. Delete the author’s name at the top of the first page. Notice that the author’s name has
remained on the other pages. This is because the Link to Previous button was deselected on the
page that follows it. (Figure 45)
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47. Now we want to set up the headers with the book title on the left pages. Select the author’s
name on page 3. (Figure 46)
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48. Click the Link to Previous button in the Header & Footer Tools panel to deselect it. (Figure 47)
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49. Our goal is to delete the author’s name on page three, but we must make sure that when we do
so, it doesn’t affect headers of pages before or after that page. So now we will select the author’s
name on page 4, and we will deselect the Link to Previous button. (Figure 48)
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50. Now, delete the author’s name on page 3. Select the Home tab and type in the title of the book
using the same font formatting as the author’s name on the even pages. Click on the Right Justify
button to move the text to the right (Inside) edge of the page.(Figure 49)
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51. Notice on page 5 that the author’s name is still on the left side of the page, and, in fact, is above
the Table of Contents. For aesthetics, you will want to have no headers above some pages. These
pages would be the Table of Contents, the initial page for chapters, pages with only images, blank
pages, and so on. Select the Header & Footer Tools tab. (Figure 50)
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52. To remove the header text above the Table of Contents, select the text and deselect the Link to
Previous button. Don’t delete the text yet. (Figure 51)
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53. Next select the text above page 6 (The page that follows the Table of Contents page), Deselect
the Link to Previous button. (Figure 52)

Home et Pagelysit  References MaSingt Review View
| B 3 TePrevious Sectisa 7 Ofterent Fast Page i HeaseetromTop: 05"
b Nest Section ¥ Ofterent 088 & Bven Pages s Focter feom Battomx 05"
Date rot Ptire (Io Go 8o <
& Teme Pactye Messer 'N‘“m 7 Show Document Test ) Wvient Asgrment Tad
et Navigation Posnn
| PO Lquwnvy

w
=
-
..
2
=
.'.
.
-
<!
-
-
=
~
o
::
| <1
-
'l
<
-~
-
-
<}
o
.
-
‘i
=
B
.v
:
-
”
=
=
.
‘.

in
&
-
:
4
-
”
s

Figure 52



54. Now go back and delete the text above the Table of Contents (On page 5). Notice that no other
pages have been affected (Figure 53)
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55. Let’s proceed to the first “Chapter” page, which in this case is the beginning of the Introduction

section. (Figure 54)
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56. Select the text above the Introduction page. Deselect the Link to Previous button. You may have
to do this also on the following page. (Figure 55)
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57. Delete the text above the Introduction page. (Figure 56)
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58. Proceed to the next chapter, Chapter One in this case. Notice that the file has been “Trained” to
not show headers above the “Chapter” headings. (Figure 57)
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59. Check later chapters to make sure that the pattern is continuing. Chapter Four look fine. (Figure
58)
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60. Next step, go back to the Table of Contents and add the chapter titles. Note, there is a method for
automatically creating and paginating a Table of Contents, but this will not be discussed here. This
is a simple book formatting tutorial for a simple book. And, this book will later become an eBook,
and adding the automatic TOC creation now will only create a fair amount of work that will need to
be done later when formatting the eBook file. (Figure 59)
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61. We will want the title and pagination spacing to be neat in the Table of Contents. Here is a
simple technique. Select all of the chapter headers in the TOC. Right Click on the selected text, drop
down and click on Paragraph. (Figure 60)
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62. The Paragraph window will open. In the Line and Page Breaks tab, click the Tabs button at the
bottom left of the window. (Figure 61)
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63. The Tabs window will open. Under Tab stop position type on a number that will place text near
the right most portion of the printable area of your document. In this case, the best value would be
4. See the 4” in the ruler above the document. (If your ruler is not visible, you may want to turn it on
in the View drop down at the top of the window). Then click on “Right” under Alignment, and we
clickon “2......." under Leader, although any choice can be made according to preference. (Figure
62)
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64. Type in the first page number value to the right of the first chapter. In this case, vii next to
INTRODUCTION. (Figure 63)
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65. Place an insertion pint to the left of the page number, and push the Tab key on you keyboard.
Notice that the page number has moved neatly to the 4” spot on the page and is now proceeded by
“....".(Figure 64)

. OUOS.4a¢ [Compatddey Mode
| Mome | cet  Pagelamout References  Malingt  Review View
3 & coppemuteconcug-iz < T X[ [0 1= iR BT | s saescee AaBbC AaBb( ?'“'
“d = Loe Replace

Styes ~

0

| P , (B 7 Ucdex A (VoA (S8 O D] | thoma [Nesosong Hesanor  tee o Chamge
Cipbomg = ) 2 Ryles

PageSof2N  Woeds ST666 D

Figure 64




66. Follow this procedure for the remaining chapters. You will have to read through you book,
noting the actual page numbers to find the values for the chapter pagination. (Figure 65)
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Figure 65



Justifying your book'’s text

There are several ways to justify the text in a book. Click on the Home tab at the top of the screen.
Notice on this page that the Introduction and lines that follow are “Center Justified.” This is OK for
portions of the book, such as the beginning of a chapter, the title page, and so on, but you probably
won’t want to center justify the main text for your book. You will likely want to either “Full Justify,”
or “Left Justify” the text. To “Full Justify” select the text that you would like to affect, and click the
right-most justification button in the Paragraph section. Do not choose the entire book file to make
this change unless you would like to justify all text the same.
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Or, you can “Left Justify” your text by selecting all text that you would like to affect and click the left-
most justification button in the paragraph section. Finally, to center portions of text, select it and
choose the middle-most button under the Paragraph section. Notice that you can also right-click on
selected text and drop down and click Paragraph to find these settings. This is the page with
centered title, and quote at the top, and “Left Justified” text.
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